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Preface

Audience for This Guide
Welcome to Release 11i of the Oracle Universal Work Queue Concepts and 
Procedures.

This guide assumes you have a working knowledge of the following:

� The principles and customary practices of your business area.

� Oracle Universal Work Queue

If you have never used Oracle Universal Work Queue, Oracle suggests you 
attend one or more of the Interaction Center training classes available through 
Oracle University.

� The Oracle Applications graphical user interface. 

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

How To Use This Guide
This document contains the information you need to understand and use Oracle 
Universal Work Queue.

� Chapter 1, "Understanding Oracle Universal Work Queue", provides overviews 
of the application and its components, explanations of key concepts, features, 
and functions.
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� Chapter 2, "Administering Oracle Universal Work Queue", provides task-based 
procedures for configuring Oracle Universal Work Queue.

� Chapter 3, "Using Oracle Universal Work Queue", provides process-oriented, 
task-based procedures for using Oracle Universal Work Queue to perform 
essential business tasks.

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation JAWS, a Windows screen 
reader, may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, JAWS may not always read a line of text that 
consists solely of a bracket or brace.

Other Information Sources
You can choose from many sources of information, including online 
documentation, training, and support services, to increase your knowledge and 
understanding of Oracle Universal Work Queue.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). Online 
help patches are available on MetaLink.
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Related Documentation
Oracle Universal Work Queue shares business and setup information with other 
Oracle Applications products. Therefore, you may want to refer to other product 
documentation when you set up and use Oracle Universal Work Queue.

You can read the documents online by choosing Library from the expandable menu 
on your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle Universal Work 
Queue (and any other Oracle Applications products). This guide also includes 
information on setting user profiles, as well as running and reviewing reports and 
concurrent processes.

You can access this user’s guide online by choosing ”Getting Started with Oracle 
Applications” from any Oracle Applications help file.

Documents Related to This Product

Oracle Universal Work Queue Concepts and Procedures
Use this guide to administer and user Oracle Universal Work Queue.

Oracle Advanced Inbound Implementation Guide
Use this guide to administer the inbound media setup for an interaction center.

Oracle Advanced Outbound Implementation Guide
Use this guide to administer the outbound media setup for an interaction center.

Oracle Interaction Center Implementation Guide
Use this guide to implement Interaction Center Server Manager.
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Oracle Scripting Implementation Guide
Use this guide to use and administer Oracle Scripting.

Oracle Interaction Center Intelligence Implementation Guide
Use this guide to use and administer Oracle Interaction Center Intelligence.

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product 
user’s guides and implementation guides.

Oracle Applications Supplemental CRM Installation Steps
This guide contains specific steps needed to complete installation of a few of the 
CRM products. The steps should be done immediately following the tasks given in 
the Installing Oracle Applications guide.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 
10.7 (NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 
11i. You cannot upgrade to Release 11i directly from releases prior to 10.7.
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Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards for Forms-Based Products. It also provides 
information to help you build your custom Oracle Forms Developer 6i forms so that 
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on Metalink
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Oracle CRM Application Foundation Implementation Guide
Many CRM products use components from CRM Application Foundation. Use this 
guide to correctly implement CRM Application Foundation.

Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle Universal 
Work Queue and reach full productivity quickly. You have a choice of educational 
environments. You can attend courses offered by Oracle University at any one of 
our many Education Centers, you can arrange for our trainers to teach at your 
facility, or you can use Oracle Learning Network (OLN), Oracle University’s online 
education utility. In addition, Oracle training professionals can tailor standard 
courses or develop custom courses to meet your needs. For example, you may want 
to use your organization’s structure, terminology, and data as examples in a 
customized training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Universal Work Queue 
working for you. This team includes your Technical Representative, Account 
Manager, and Oracle’s large staff of consultants and support specialists with 
expertise in your business area, managing an Oracle8i server, and your hardware 
and software environment.

OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.
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Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support, and office 
automation, as well as Oracle Applications, an integrated suite of more than 160 
software modules for financial management, supply chain management, 
manufacturing, project systems, human resources and customer relationship 
management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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1
Understanding Oracle Universal Work

Queue

This topic group provides overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle or third-party applications. 

Oracle Universal Work Queue is a portal for accessing agent work within an 
interaction center. Agent work includes application work, such as service requests, 
and media work, such as inbound telephony calls. When you select a work item, 
Oracle Universal Work Queue launches the appropriate application and, if 
necessary, a media controller, such as a softphone.

The items on your desktop include:

� Universal Work Queue: Displays counts and summary lists of application and 
media work.

� icWork Controller: Displays tabs for “remote” control access to work items, 
application notices, Oracle Universal Work Queue server status, and a 
softphone.

See Also
� Chapter 2, "Administering Oracle Universal Work Queue"

� Chapter 3, "Using Oracle Universal Work Queue"
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2
Administering Oracle Universal Work

Queue

This topic group provides task-based procedures for configuring Oracle Universal 
Work Queue.

Topics include:

� Section 2.1, "Configuring a Media Screen Pop for Oracle Universal Work 
Queue"

� Section 2.2, "Integrating with Oracle Interaction Blending"

� Section 2.3, "Integrating with Oracle Interaction Center Intelligence"

See Also
� Chapter 1, "Understanding Oracle Universal Work Queue"

� Chapter 3, "Using Oracle Universal Work Queue"

2.1 Configuring a Media Screen Pop for Oracle Universal Work Queue
Classifications (for example, “Gold Support”) can be assigned to calls based on the 
information in the call (for example, the number dialed by the caller). Then, for a 
specific type of media, the classification is mapped to an application window. When 
an agent requests delivery of that media type, the mapped business application is 
launched.

Use this procedure to associate media work with a CRM business application. 
When a media item is delivered to the Oracle Universal Work Queue desktop, a 
CRM business application is launched based on the media type and the media item 
classification.
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Login
HTML Login URL

Responsibility
UWQ HTML Administrator

Prerequisites
None

Steps
1. Select the Media Actions tab.

The Media Classification Action Association page appears.

2. In the Media Type field, select the type of media (for example, Inbound 
Telephony).

3. In the Classification field, type in the name of the media item classification that 
will trigger the media action (screen pop).

4. In the Media Action field, select the business application that will be launched 
when a media item of the specified type with the specified classification is 
selected from a work node.

5. To clear a row, click the button in the Remove column to the left of the media 
classification action association.

6. To save your work, click Update.

The Media Classification Action Association page appears.

7. To delete a media classification action association, select the Remove checkbox 
to the left of the media type and click Update.

See Also
� Section 2.2, "Integrating with Oracle Interaction Blending"

� Section 2.3, "Integrating with Oracle Interaction Center Intelligence"

Note: Use a blank field in the Classification column to indicate the 
default media action for an unclassified media item.
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2.2 Integrating with Oracle Interaction Blending

Oracle Interaction Blending must be installed and configured. Oracle Interaction 
Blending dynamically moves agents between nodes and media types based on the 
service levels for the interaction center. For information about implementing Oracle 
Interaction Blending, see Oracle Interaction Blending Implementation Guide.

To enable media work blending for Oracle Universal Work Queue, set the Blending 
Style profile option to Forced Blended. When media work blending is enabled for 
Oracle Universal Work Queue, the Media node is replaced with a Blended node.

See Also
� Section 2.1, "Configuring a Media Screen Pop for Oracle Universal Work 

Queue"

� Section 2.3, "Integrating with Oracle Interaction Center Intelligence"

2.3 Integrating with Oracle Interaction Center Intelligence

To record Oracle Universal Work Queue session data for Oracle Interaction Center 
Intelligence, set the Oracle Universal Work Queue server database parameter 
ENABLE_SESSION_HISTORY to TRUE. The default is FALSE.

Optionally, when you start the Oracle Universal Work Queue server, use the 
enable_session_history command line parameter turn on data recording. The 
database parameter overrides the command line parameter.

The Oracle Universal Work Queue server records the following information in the 
database:

� Agent login

� Agent logout

Note: This procedure applies to media work only. This procedure 
is only required when implementing Oracle Interaction Blending.

Note: This procedure applies to media work only. This procedure 
is only required when implementing Oracle Interaction Center 
Intelligence.
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� Media item requests

� Media item deliveries

The additional server activity can affect the performance of the Oracle Universal 
Work Queue server.

Oracle Interaction Center Intelligence must be installed and configured. For 
information about implementing Oracle Interaction Center Intelligence, see Oracle 
Interaction Center Intelligence Implementation Guide.

See Also
� Section 2.1, "Configuring a Media Screen Pop for Oracle Universal Work 

Queue"

� Section 2.2, "Integrating with Oracle Interaction Blending"
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3
Using Oracle Universal Work Queue

This topic group provides process-oriented, task-based procedures for using Oracle 
Universal Work Queue to perform essential business tasks.

Topics include:

� Section 3.1, "Getting Started with Oracle Universal Work Queue"

� Section 3.2, "Managing Your Work Items"

� Section 3.3, "Using the Softphone in the icWork Controller"

� Section 3.4, "Managing Notices in the icWork Controller"

� Section 3.5, "Taking a Break from Your Oracle Universal Work Queue Session"

� Section 3.6, "Ending Your Oracle Universal Work Queue Session"

See Also
� Chapter 1, "Understanding Oracle Universal Work Queue"

� Chapter 2, "Administering Oracle Universal Work Queue"

3.1 Getting Started with Oracle Universal Work Queue
The Universal Work Queue window displays your work items. Use this procedure 
to access the Universal Work Queue window.

Login
Self Service Login URL
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Responsibility
Customer Support or TeleSales Agent

Prerequisites
For application work:

� You must be defined as an employee in Oracle Applications.

� Your employee record must be linked to your Oracle Applications user account.

� Oracle Universal Work Queue profile options must be configured for 
application work.

� You must be defined as a CRM resource in Oracle Applications.

� You must have the appropriate CRM roles in your CRM resource record.

� You should identify the refresh strategy for the work item count in Universal 
Work Queue.

Work item counts may be refreshed when the Universal Work Queue window 
opens, after each delivery of a media work item, or manually (see Section 3.2.2, 
"Refreshing Work Counts"). The refresh strategy is set by your system 
administrator using the IEU: Desktop: UI: Refresh Style profile option. The 
refresh strategy may be the same for all agents in your interaction center or it 
may differ based on application, responsibility, or even user account.

For media work:

� You must satisfy the prerequisites for application work.

� Oracle interaction center information must be defined in your CRM resource 
record.

� Oracle Universal Work Queue profile options must be configured for media 
work.

� Oracle TeleSales or Oracle TeleService profile options must be configured for 
media work.

� You should identify your phone extension. For example, if your phone number 
is 123-456-7890 and the length of internal extensions for your interaction center 
is set to five, then your phone extension is 67890.

You may have to enter it when you navigate to Universal Work Queue. If your 
system administrator has entered your phone extension in the IEU: Optional: 
Phone Extension profile option for your user account, then you will not have to 
enter your phone extension.
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Steps
1. Navigate to the Universal Work Queue window.

If you are enabled for application work only, then the Universal Work Queue 
window and the icWork Controller appear.

If you are enabled for media work, then the Phone Extension window may 
appear. 

2. If the Phone Extension window appears, enter the extension of your physical 
phone and then click OK. For example, if your phone number is 123-456-7890 
and the length of internal extensions for your interaction center is set to five, 
then enter 67890.

The Oracle Universal Work Queue window has two panes. The left pane lists 
the available work nodes and the count, or number, of work items in each node. 
The right pane displays the details of the work items in a selected node.

Work item counts may be refreshed when the Universal Work Queue window 
opens, after each delivery of a media work item, or manually. The refresh 
strategy is set by your system administrator using the IEU: Desktop: UI: Refresh 
Style profile option. You may manually refresh work item counts at any time.

3. To manually refresh work counts, from the Tools menu, choose Refresh.

See Also
� Section 3.2, "Managing Your Work Items"

Application Procedure

TeleService (Support) � In the Navigator window, on the Functions tab, choose 
Universal Work Queue.

TeleSales 1. In the Navigator window, on the Functions tab, choose 
eBusiness Center.

2. From the Tools menu, choose Universal Work Queue.

Note: If a phone extension is provided in the IEU: Optional: 
Phone Extension profile option for your user account, then Oracle 
Universal Work Queue uses that phone extension for media work 
and does not display the Phone Extension window. 
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� Section 3.3, "Using the Softphone in the icWork Controller"

� Section 3.4, "Managing Notices in the icWork Controller"

� Section 3.5, "Taking a Break from Your Oracle Universal Work Queue Session"

� Section 3.6, "Ending Your Oracle Universal Work Queue Session"

3.2 Managing Your Work Items
Topics include:

� Section 3.2.1, "Requesting the Next Priority Work Item"

� Section 3.2.2, "Refreshing Work Counts"

� Section 3.2.3, "Browsing Application Work Items"

� Section 3.2.4, "Receiving Inbound Telephone Calls"

� Section 3.2.5, "Making Outbound Telephone Calls"

� Section 3.2.6, "Returning Web Callbacks"

� Section 3.2.7, "Managing Blended Calls"

� Section 3.2.8, "Viewing Your Email Workload"

� Section 3.2.9, "Modifying Your Node Order"

See Also
� Section 3.1, "Getting Started with Oracle Universal Work Queue"

� Section 3.3, "Using the Softphone in the icWork Controller"

� Section 3.4, "Managing Notices in the icWork Controller"

� Section 3.5, "Taking a Break from Your Oracle Universal Work Queue Session"

� Section 3.6, "Ending Your Oracle Universal Work Queue Session"

3.2.1 Requesting the Next Priority Work Item
The WorkList node holds application work of all types that are owned by or 
assigned to you, or a group or team to which you belong. Each work item in the 
WorkList node is prioritized relative to other work items in the node -- regardless of 
type. The priority is determined not only by the details of the work item, but also by 
a global prioritization strategy for work of any type.
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Use this procedure to request the next priority work item in your WorkList.

Login
Self Service Login URL

Responsibility
Customer Support or TeleSales Agent

Prerequisites
� Navigate to Universal Work Queue (see Section 3.1, "Getting Started with 

Oracle Universal Work Queue").

Steps
1. In the Universal Work Queue window, select the WorkList node and then click 

Get Work.

The appropriate application window opens and displays the details of the next 
priority work item. When your work is complete, save your work in the 
application window.

2. To request the next work item from the WorkList node, click Get Work in the 
Universal Work Queue window or Next Work in the icWork Controller.

See Also
� Section 3.2.2, "Refreshing Work Counts"

� Section 3.2.3, "Browsing Application Work Items"

� Section 3.2.4, "Receiving Inbound Telephone Calls"

� Section 3.2.5, "Making Outbound Telephone Calls"

� Section 3.2.6, "Returning Web Callbacks"

� Section 3.2.7, "Managing Blended Calls"

� Section 3.2.8, "Viewing Your Email Workload"

� Section 3.2.9, "Modifying Your Node Order"

Note: To browse and select a specific application work item, see 
Section 3.2.3, "Browsing Application Work Items".
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3.2.2 Refreshing Work Counts
Work item counts may be refreshed when the Universal Work Queue window 
opens, after each delivery of a media work item, or manually. You may manually 
refresh work item counts at any time.

The refresh strategy is set by your system administrator using the IEU: Desktop: UI: 
Refresh Style profile option. The refresh strategy may be the same for all agents in 
your interaction center or it may differ based on application, responsibility, or even 
user account.

The following table describes the possible refresh styles for Oracle Universal Work 
Queue.

Use this procedure to manually refresh work item counts.

Login
Self Service Login URL

Responsibility
Customer Support or TeleSales Agent

Prerequisites
� Navigate to Universal Work Queue (see Section 3.1, "Getting Started with 

Oracle Universal Work Queue").

Steps
1. From the Tools menu, choose Refresh.

Refresh Style Description

Automatic Work item counts are refreshed:

� when the Universal Work Queue window opens

� after each delivery of a media work item

Login Only Work item counts are refreshed when the Universal Work Queue 
window opens. Thereafter, you must manually refresh the work item 
counts.

Manual Work item counts are not refreshed when the Universal Work Queue 
window opens. You must manually refresh the work item counts. 



Managing Your Work Items

Using Oracle Universal Work Queue 3-7

You cannot use the Universal Work Queue window until after the count is 
refreshed.

See Also
� Section 3.2.1, "Requesting the Next Priority Work Item"

� Section 3.2.3, "Browsing Application Work Items"

� Section 3.2.4, "Receiving Inbound Telephone Calls"

� Section 3.2.5, "Making Outbound Telephone Calls"

� Section 3.2.6, "Returning Web Callbacks"

� Section 3.2.7, "Managing Blended Calls"

� Section 3.2.8, "Viewing Your Email Workload"

� Section 3.2.9, "Modifying Your Node Order"

3.2.3 Browsing Application Work Items
The individual work item nodes allow you to browse lists of individual work items 
and select a specific item to work on.

Use this procedure to browse and select a work item.

Login
Self Service Login URL

Responsibility
Customer Support or TeleSales Agent

Prerequisites
� Navigate to Universal Work Queue (see Section 3.1, "Getting Started with 

Oracle Universal Work Queue").

Note: To work on items that have been prioritized, see Requesting 
the Next Priority Work Item.
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Steps
1. In the Universal Work Queue window, select a work item node. If necessary, 

expand the application node to access the work item nodes.

The work items are listed in the detail pane.

2. Select a work item and then click Get Work.

The appropriate application window opens and displays the details of the work 
item. When your work is complete, save your work in the application window.

3. To select another work item, select a work item and then click Get Work in the 
Universal Work Queue window.

See Also
� Section 3.2.1, "Requesting the Next Priority Work Item"

� Section 3.2.2, "Refreshing Work Counts"

� Section 3.2.4, "Receiving Inbound Telephone Calls"

� Section 3.2.5, "Making Outbound Telephone Calls"

� Section 3.2.6, "Returning Web Callbacks"

� Section 3.2.7, "Managing Blended Calls"

� Section 3.2.8, "Viewing Your Email Workload"

� Section 3.2.9, "Modifying Your Node Order"

3.2.4 Receiving Inbound Telephone Calls
When the interaction center receives an inbound call, the call is classified and then 
routed to a pool of one or more agents. Your Inbound Telephony node displays the 
number of inbound calls that have been routed to agent groups to which you 
belong.

Inbound call counts are categorized by call classification. Only call classifications 
with available inbound calls are listed, even though you may be eligible to answer 
calls in other call classifications.

Other agents may be eligible to answer calls in a call classification. The inbound call 
count for a call classification will decrease when another agent answers a call. When 
the last remaining call for a call classification is answered, the call classification will 
disappear from your inbound telephony node.

Use this procedure to start receiving inbound calls.
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Login
Self Service Login URL

Responsibility
Customer Support or TeleSales Agent

Prerequisites
� Review the procedures for using the softphone in the icWork Controller.

� Navigate to Universal Work Queue (see Section 3.1, "Getting Started with 
Oracle Universal Work Queue").

Steps
1. In the Universal Work Queue window, expand the Media node and click 

Inbound Telephony.

Inbound calls counts are categorized by call classification in the detail pane. 

2. To start receiving inbound calls, click a call classification and then click Get 
Work.

The appropriate application window opens and displays the details of the work 
item.

3. To end the call and complete your work in the current interaction:

a. Click Release on the softphone to hang up the call.

b. Click Wrap Up in the application window.

c. Complete your work.

4. To end the interaction and request another call of the same classification:

a. Click End Interaction in the application window.

b. Select a call outcome.

You are now ready to receive inbound calls of the same classification.

5. To end the interaction and suspend call delivery:

Note: You do not have to click Next Call in the icWork Controller.
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a. Click Cancel Media Request in the Universal Work Queue window or 
Cancel in the icWork Controller.

b. Click End Interaction in the application window.

c. Select a call outcome.

6. To request calls of a different classification:

a. Click Cancel Media Request in the Universal Work Queue window or 
Cancel in the icWork Controller.

b. Click End Interaction in the application window.

c. Select a call outcome.

d. Click a different call classification and then click Get Work in the Universal 
Work Queue window.

See Also
� Section 3.2.1, "Requesting the Next Priority Work Item"

� Section 3.2.2, "Refreshing Work Counts"

� Section 3.2.3, "Browsing Application Work Items"

� Section 3.2.5, "Making Outbound Telephone Calls"

� Section 3.2.6, "Returning Web Callbacks"

� Section 3.2.7, "Managing Blended Calls"

� Section 3.2.8, "Viewing Your Email Workload"

� Section 3.2.9, "Modifying Your Node Order"

Note: If a call is already on its way to you when you suspend call 
delivery, then you will receive one last call before your call delivery 
is suspended.

Note: If a call is already on its way to you when you suspend call 
delivery, then you will receive one last call before your call delivery 
is suspended.
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3.2.5 Making Outbound Telephone Calls
Use this procedure to start making outbound calls.

Login
Self Service Login URL

Responsibility
Customer Support or TeleSales Agent

Prerequisites
� Review the procedures for using the softphone in the icWork Controller.

� Navigate to Universal Work Queue (see Section 3.1, "Getting Started with 
Oracle Universal Work Queue").

Steps
1. In the Universal Work Queue window, expand the Media node and click 

Outbound Telephony.

Outbound calls counts are categorized by campaign in the detail pane. 

2. To start receiving outbound calls, click a campaign and then click Get Work.

The appropriate application window opens and displays the details of the work 
item.

3. If necessary, place the call using the softphone.

4. To end the call and complete your work in the current interaction:

a. Click Release on the softphone to hang up the call.

b. Click Wrap Up in the application window.

c. Complete your work.

5. To end the interaction and request another call of the same campaign:

a. Click End Interaction in the application window.

b. Select a call outcome.

Note: You do not have to click Next Call in the icWork Controller.
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You are now ready to handle an outbound calls of the same campaign.

6. To end the interaction and suspend call delivery:

a. Click Cancel Media Request in the Universal Work Queue window or 
Cancel in the icWork Controller.

b. Click End Interaction in the application window.

c. Select a call outcome.

7. To handle calls of a different campaign:

a. Click Cancel Media Request in the Universal Work Queue window or 
Cancel in the icWork Controller.

b. Click End Interaction in the application window.

c. Select a call outcome.

d. Click a different call campaign and then click Get Work in the Universal 
Work Queue window.

See Also
� Section 3.2.1, "Requesting the Next Priority Work Item"

� Section 3.2.2, "Refreshing Work Counts"

� Section 3.2.3, "Browsing Application Work Items"

� Section 3.2.4, "Receiving Inbound Telephone Calls"

� Section 3.2.6, "Returning Web Callbacks"

� Section 3.2.7, "Managing Blended Calls"

� Section 3.2.8, "Viewing Your Email Workload"

Note: If a call is already on its way to you when you suspend call 
delivery, then you will receive one last call before your call delivery 
is suspended.

Note: If a call is already on its way to you when you suspend call 
delivery, then you will receive one last call before your call delivery 
is suspended.
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� Section 3.2.9, "Modifying Your Node Order"

3.2.6 Returning Web Callbacks
Typically a customer makes callback request through web page. The request is 
relayed to the interaction center and the customer is called back when an agent 
become available.

Use this procedure to start returning callbacks.

Login
Self Service Login URL

Responsibility
Customer Support or TeleSales Agent

Prerequisites
� Review the procedures for using the softphone in the icWork Controller.

� Navigate to Universal Work Queue (see Section 3.1, "Getting Started with 
Oracle Universal Work Queue").

Steps
1. In the Universal Work Queue window, expand the Media node and click Web 

Callback.

Web callback counts are categorized by call classification in the detail pane. 

2. To start returning web callbacks, click a call classification and then click Get 
Work.

The appropriate application window opens and displays the details of the work 
item.

3. To end the call and complete your work in the current interaction:

a. Click Release on the softphone to hang up the call.

b. Click Wrap Up in the application window.

c. Complete your work.

4. To end the interaction and request another call of the same classification:

a. Click End Interaction in the application window.
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b. Select a call outcome.

You are now ready to receive inbound calls of the same classification.

5. To end the interaction and suspend call delivery:

a. Click Cancel Media Request in the Universal Work Queue window or 
Cancel in the icWork Controller.

b. Click End Interaction in the application window.

c. Select a call outcome.

6. To request calls of a different classification:

a. Click Cancel Media Request in the Universal Work Queue window or 
Cancel in the icWork Controller.

b. Click End Interaction in the application window.

c. Select a call outcome.

d. Click a different call classification and then click Get Work in the Universal 
Work Queue window.

See Also
� Section 3.2.1, "Requesting the Next Priority Work Item"

� Section 3.2.2, "Refreshing Work Counts"

� Section 3.2.3, "Browsing Application Work Items"

Note: You do not have to click Next Call in the icWork Controller.

Note: If a call is already on its way to you when you suspend call 
delivery, then you will receive one last call before your call delivery 
is suspended.

Note: If a call is already on its way to you when you suspend call 
delivery, then you will receive one last call before your call delivery 
is suspended.
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� Section 3.2.4, "Receiving Inbound Telephone Calls"

� Section 3.2.5, "Making Outbound Telephone Calls"

� Section 3.2.7, "Managing Blended Calls"

� Section 3.2.8, "Viewing Your Email Workload"

� Section 3.2.9, "Modifying Your Node Order"

3.2.7 Managing Blended Calls
The blending mode is set by your system administrator using the IEU: Blending 
Style profile option. When media work blending is enabled, the Media node is 
replaced with a Blended node.

Use this procedure to start handling blended calls.

Login
Self Service Login URL

Responsibility
Customer Support or TeleSales Agent

Prerequisites
� Review the procedures for using the softphone in the icWork Controller.

� Navigate to Universal Work Queue (see Section 3.1, "Getting Started with 
Oracle Universal Work Queue").

Steps
1. In the Universal Work Queue window, click Blended.

Media work is categorized by type in the detail pane. 

2. To start handling blended calls, click a node and then click Get Work.

The appropriate application window opens and displays the details of the work 
item.

3. To end the call and complete your work in the current interaction:

a. Click Release on the softphone to hang up the call.

b. Click Wrap Up in the application window.
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c. Complete your work.

4. To end the interaction and request another call of the same classification:

a. Click End Interaction in the application window.

b. Select a call outcome.

You are now ready to receive inbound calls of the same classification.

5. To end the interaction and suspend call delivery:

a. Click Cancel Media Request in the Universal Work Queue window or 
Cancel in the icWork Controller.

b. Click End Interaction in the application window.

c. Select a call outcome.

6. To request calls of a different classification:

a. Click Cancel Media Request in the Universal Work Queue window or 
Cancel in the icWork Controller.

b. Click End Interaction in the application window.

c. Select a call outcome.

d. Click a different call classification and then click Get Work in the Universal 
Work Queue window.

Note: You do not have to click Next Call in the icWork Controller.

Note: If a call is already on its way to you when you suspend call 
delivery, then you will receive one last call before your call delivery 
is suspended.

Note: If a call is already on its way to you when you suspend call 
delivery, then you will receive one last call before your call delivery 
is suspended.
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See Also
� Section 3.2.1, "Requesting the Next Priority Work Item"

� Section 3.2.2, "Refreshing Work Counts"

� Section 3.2.3, "Browsing Application Work Items"

� Section 3.2.4, "Receiving Inbound Telephone Calls"

� Section 3.2.5, "Making Outbound Telephone Calls"

� Section 3.2.7, "Managing Blended Calls"

� Section 3.2.8, "Viewing Your Email Workload"

� Section 3.2.9, "Modifying Your Node Order"

3.2.8 Viewing Your Email Workload
You cannot launch Oracle eMail Center from Oracle Universal Work Queue. To 
launch Oracle eMail Center, you must go to the HTML Login URL and enter your 
username and password.

Use this procedure to view your email work load.

Login
Self Service Login URL

Responsibility
Customer Support or TeleSales Agent

Prerequisites
� Navigate to Universal Work Queue (see Section 3.1, "Getting Started with 

Oracle Universal Work Queue").

Steps
1. In the Universal Work Queue window, expand the Media node and click Email.

A summary is displayed in the detail pane.

See Also
� Section 3.2.1, "Requesting the Next Priority Work Item"

� Section 3.2.2, "Refreshing Work Counts"
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� Section 3.2.3, "Browsing Application Work Items"

� Section 3.2.4, "Receiving Inbound Telephone Calls"

� Section 3.2.5, "Making Outbound Telephone Calls"

� Section 3.2.6, "Returning Web Callbacks"

� Section 3.2.7, "Managing Blended Calls"

� Section 3.2.9, "Modifying Your Node Order"

3.2.9 Modifying Your Node Order
Use this procedure to change the order of your Universal Work Queue nodes.

Login
Self Service Login URL

Responsibility
Customer Support or TeleSales Agent

Preferences

Prerequisites
None

Steps
1. Choose Edit > Preferences > Profile Options.

The Personal Profile Values window appear.

2. Choose View > Query by Example > Enter (F11).

3. In the Profile Name field, enter IEU%.

4. Choose View > Query by Example > Run (Ctrl + F11)

The Oracle Universal Work Queue personal profile values are displayed.

5. In the IEU: Queue Order: <nodename> profile options, select a number 
between 1 through 26. 

Nodes are displayed in ascending order in the Universal Work Queue window.
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See Also
� Section 3.2.1, "Requesting the Next Priority Work Item"

� Section 3.2.2, "Refreshing Work Counts"

� Section 3.2.3, "Browsing Application Work Items"

� Section 3.2.4, "Receiving Inbound Telephone Calls"

� Section 3.2.5, "Making Outbound Telephone Calls"

� Section 3.2.6, "Returning Web Callbacks"

� Section 3.2.7, "Managing Blended Calls"

� Section 3.2.8, "Viewing Your Email Workload"

3.3 Using the Softphone in the icWork Controller
The softphone is a telephone user interface on your desktop. If one of the media 
work nodes is enabled, then the softphone is displayed in the Phone tab of the 
icWork Controller. 

The color of the softphone line buttons (for example, Line 1) indicate the status of 
the line. Use the following table to interpret the color.

Use the following procedure to operate the softphone.

Login
Self Service Login URL

Responsibility
Customer Support or TeleSales Agent

Prerequisites
� Verify whether softphone auto-hold is enabled:

If the line color is... Then the line is...

Gray Selected

Green In use

Yellow Ringing
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– For the Lucent Avaya switch with Dialogic CT-Connect middleware, 
softphone auto-hold is enabled. Any current call will be placed on hold 
when you click another line button. To hang up the current call, click 
Release.

– If softphone auto-hold is not enabled, then the current call will end when 
you click another line button. To put any current call on hold, you must 
click Hold.

� Navigate to Universal Work Queue (see Section 3.1, "Getting Started with 
Oracle Universal Work Queue").

� Start handling telephone calls.

Steps
1. In the icWork Controller, click the Phone tab.

Use the following table to find procedures for operating the softphone.

To... Do this...

Answer a call Click a yellow line button (for example, Line 1).

Note: If the switch is set for auto-hold, then 
clicking another line button will place any 
current call on hold.

If the switch is not set for auto-hold, then any 
current call, not on hold, will end when you 
click another line button.

Place a call 1. Click a gray line button (for example, Line 
1).

Note: If the switch is set for auto-hold, then 
clicking another line button will place any 
current call on hold.

If the switch is not set for auto-hold, then 
any current call, not on hold, will end when 
you click another line button.

2. Click the number buttons, type the 
numbers using your keyboard, or select a 
previously entered number.

3. Click Dial.
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Enter a response to a voice prompt 1. Click the number buttons, type the 
numbers using your keyboard, or select a 
previously entered number.

2. Click Dial.

Place a call on hold Click Hold.

The line button for a holding line blinks green.

Note: If the switch is set for auto-hold, then 
clicking another line button (for example, Line 
1) will also place the current call on hold.

If the switch is not set for auto-hold, then any 
current call, not on hold, will end when you 
click another line button.

Remove a call from hold The line button for a holding line blinks green.

If only one line is holding, Click Hold.

If multiple lines are holding, click the line 
button (for example, Line 1) for the holding line.

Hang up a call Click Release or click another line button (Line 
1)

Note: If the switch is set for auto-hold, then 
clicking another line button will place the 
current call on hold and not release the call. You 
must return to the line and then click Release.

If the switch is not set for auto-hold, then any 
current call, not on hold, will end when you 
click another line button.

To... Do this...
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Transfer a call To transfer a call with the softphone on a 
non-Aspect switch:

1. With the caller on the line, dial the 
number to which you want to transfer 
the call.

2. Click Transfer.

The call is put on hold and the number is 
dialed.

3. When the call is answered, click Transfer 
again.

To transfer a call with the softphone on an 
Aspect switch:

1. Click Hold to place the call on hold.

2. Select a gray line button.

3. Dial the number to which you want to 
transfer the call.

4. When the call is answered, click Transfer.

Conference a call To conference a call with the softphone on a 
non-Aspect switch:

1. With the caller on the line, dial the 
number that you want to add to the 
conference call.

2. Click Conference.

The call is put on hold and the number is 
dialed.

3. When the call is answered, click 
Conference again.

To conference a call with the softphone on an 
Aspect switch:

1. Click Hold to place the call on hold.

2. Select a gray line button.

3. Dial the number that you want to add to 
the conference call.

4. When the call is answered, click 
Conference.

To... Do this...
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See Also
� Section 3.1, "Getting Started with Oracle Universal Work Queue"

� Section 3.2, "Managing Your Work Items"

� Section 3.4, "Managing Notices in the icWork Controller"

� Section 3.5, "Taking a Break from Your Oracle Universal Work Queue Session"

� Section 3.6, "Ending Your Oracle Universal Work Queue Session"

3.4 Managing Notices in the icWork Controller
Applications can send notices about work items or application events directly to 
you. Notices include assignment of a work item, change in status of a work item, or 
escalation of a work item. 

Forward calls When you are not on a call, click the number 
buttons, type the numbers using your keyboard, 
or select a previously entered number to enter 
the number to which calls are to be forwarded 
and then click Forward. 

The Forward button blinks green.

Stop forwarding calls When calls are being forwarded, the Forward 
button blinks green.

Click Forward.

Indicate readiness for calls. Click Next Call.

Suspend calls. Click Cancel.

Note: If a call is already on its way to you before 
you click Cancel, then you will receive one 
more call before your calls are suspended.

Request the next priority application 
work item from your WorkList

Click Next Work.

Take a break 1. Click Break.

2. Select a break reason.

3. Click OK.

To... Do this...
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Oracle Universal Work Queue checks for notices periodically based on the Oracle 
Universal Work Queue profile options. If Oracle Universal Work Queue find new 
messages, then icWork Controller will be brought to the top of your desktop.

Notices are displayed in the Notices tab of the icWork Controller. Use the following 
procedure to manage your notices.

Login
Self Service Login URL

Responsibility
Customer Support or TeleSales Agent

Prerequisites
� Navigate to Universal Work Queue (see Section 3.1, "Getting Started with 

Oracle Universal Work Queue").

Steps
1. In the icWork Controller, click the Notices tab.

See Also
� Section 3.1, "Getting Started with Oracle Universal Work Queue"

� Section 3.2, "Managing Your Work Items"

� Section 3.3, "Using the Softphone in the icWork Controller"

� Section 3.5, "Taking a Break from Your Oracle Universal Work Queue Session"

� Section 3.6, "Ending Your Oracle Universal Work Queue Session"

To... Do this...

Navigate through your notices Click the arrow buttons.

Acknowledge receipt of a new notice Click ACK.

Clear a notice from the Notices tab Click CLR.

Filter your notices Select a filter from the Message Filter list.

Check for new notices Click Refresh.
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3.5 Taking a Break from Your Oracle Universal Work Queue Session
Use this procedure to take a formal break.

Login
Self Service Login URL

Responsibility
Customer Support or TeleSales Agent

Prerequisites
� Navigate to Universal Work Queue (see Section 3.1, "Getting Started with 

Oracle Universal Work Queue").

Steps
1. In the icWork Controller, click Break.

2. In the Break Reason window, select the reason for the break and then click OK.

3. To resume work, do one of the following:

� In Universal Work Queue window, select a node and then click Get Work.

� In the icWork Controller, click Next Work to receive the next priority 
application work item.

� In the icWork Controller, click Next Call to handle the next media work 
item of the current type.

See Also
� Section 3.1, "Getting Started with Oracle Universal Work Queue"

� Section 3.2, "Managing Your Work Items"

� Section 3.3, "Using the Softphone in the icWork Controller"

� Section 3.4, "Managing Notices in the icWork Controller"

� Section 3.6, "Ending Your Oracle Universal Work Queue Session"

3.6 Ending Your Oracle Universal Work Queue Session
Use this procedure to close the Oracle Universal Work Queue window.
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Login
Self Service Login URL

Responsibility
Customer Support or TeleSales Agent

Prerequisites
� Navigate to Universal Work Queue (see Section 3.1, "Getting Started with 

Oracle Universal Work Queue").

Steps
1. Close the Universal Work Queue window or exit from Oracle Applications.

The Break Reason window appears.

2. In the Break Reason window, select the break reason and then click OK.

See Also
� Section 3.1, "Getting Started with Oracle Universal Work Queue"

� Section 3.2, "Managing Your Work Items"

� Section 3.3, "Using the Softphone in the icWork Controller"

� Section 3.4, "Managing Notices in the icWork Controller"

� Section 3.5, "Taking a Break from Your Oracle Universal Work Queue Session"
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